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PURPOSE:  The Coastal and Hydraulics Engineering Technical Note (CHETN) herein presents 
Inlet, Nearshore, and Littoral Enhancement Tool for Geographic Information Systems 
(INLETGIS) and describes a methodology for an objective, rapid inlet shoal and channel analysis 
through classification schemes using aerial photography and the INLETGIS extension for 
ArcView™ 3.x Geographic Information System (GIS).   
 
BACKGROUND:  Maintenance of tidal inlets and tidal inlet channels has always been a costly 
and time-consuming activity dependent upon condition surveys.  Barriers to inlet maintenance 
include budget restrictions, weather, sea-state conditions, permit restrictions, and highly dynamic 
processes.  These factors make planning and design of maintenance projects difficult.  However, 
dredging and reconstruction of inlets are necessary burdens at many sites for purposes of 
commercial, recreational, and defense navigation, as well as shoreline and habitat preservation.  
Digital image analysis of aerial photography is a tool that is currently under-utilized in 
examining tidal inlet dynamics.  Remote sensing techniques for such imagery have been 
developed and are applied herein to two inlets on Long Island, NY, to analyze channel and shoal 
dynamics.  A classification scheme using spectral reflectance pattern recognition (Figure 1) is 
applied to the water and shoal portions of a digital historical photoset of Shinnecock and 
Moriches Inlets in New York to determine where channels, sub-tidal shoals, inter-tidal shoals, 
and super-tidal shoals spatially occur in the image.  Once a classification scheme has been 
created, temporal pattern recognition from one photograph to the next photograph in time may 
also be used to analyze changes in channeling and shoaling.  The INLETGIS extension to 
ArcView™ 3.x was developed to facilitate this process by providing a set of tools which 
automate many of the steps involved in shoal and channel change analysis using aerial imagery.  
The result is a tool package that provides rapid data turn-around, less subjectivity, and a gentle 
learning curve, thus catering to users with a broad range of scientific and engineering 
backgrounds in need of a rapid, objective image analysis tool.   
 
Some possible applications for applying a classification method like the one presented in this 
Technical Note include:   

a. Rapid assessment of conditions present at the time the aerial photograph was taken.   
b. Historical change analysis.   
c. Shoal movement.   
d. Channel migration analysis.   
e. Area calculations of shoals and channels.   
f. Sediment budget analysis.   
g. Determination of erosion or accretion “hot spots.”   
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Figure 1.  Classification scheme showing shoals and channels 

 
The primary benefit from using these remote sensing techniques is after the initial set-up, 
these methods provide rapid analysis of inlet dynamics, while remaining much more 
objective than traditional channel and shoal classification by “eye”.  Although these 
methods are site specific, adjustments to the spectral response classification may be made 
to incorporate other tidal inlets.  Implementation of these remote sensing techniques 
could lead to improvements in planning, design, and maintenance of tidal inlets in order 
to optimize channeling and shoaling for efficient sand transfer while minimizing 
shoreline erosion due to the scouring effects of water currents.   
 
INSTALLING INLETGIS 
 
The installation of INLETGIS is identical to that of most other ArcView™ 3.x extensions.  
The file INLETGIS.avx must first be placed in the ArcView™ extension directory 
(windows default path is:  $\ESRI\AV_GIS30\ ARCVIEW\EXT32).  Then, under the 
FILE menu in ArcView™, select Extensions, check the box next to INLETGIS, and click 
the OK button.  One important step to note in the installation process is that the 
ArcView™ ImageAnalysis™ extension must be installed before INLETGIS is installed.  
This is necessary because INLETGIS expands upon the capabilities of ImageAnalysis™ 
and utilizes many of ImageAnalysis’™ features.  Once the INLETGIS extension is 
installed and loaded into ArcView™, the INLET menu and four INLETGIS buttons are 
present in all ArcView™ View documents as shown in Figure 2.   
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Figure 2.  The menu and buttons added to the ArcView™ interface when the INLETGIS extension 

is loaded 

 

METHODS FOR SHOAL AND CHANNEL ANALYSIS 
 
In the following section, the methods employed in order to conduct the inlet morphology 
analysis are outlined in detail.  The steps are organized in sequential order, although not 
all steps are necessary in every case.  One must first determine what specific end product 
is desired before conducting the steps, as certain steps may be altered for different types 
of analyses.  In all cases ArcView ImageAnalysis™ extension package must be installed 
along with ArcView GIS 3.x in order to conduct the following methods (Note:  as of the 
date of this technical note publication, the INLETGIS extension has not been developed 
for ArcView 8.x, therefore it is necessary to use ArcView 3.x in order to conduct the 
analyses discussed herein).   
 
Aerial Image Rectification 
 
In order to use an aerial image for any kind of spatial analysis, one must first place the 
image into a known coordinate system.  This is achieved by referencing pixels in the 
image that represent a known stationary location to known, and preferably “real-world” 
coordinates for that location.  Pixels may be referenced to entered coordinates, control 
points on rectified engineering drawings, or to control pixels in other previously 
georeferenced images.  With enough control points are spread out throughout the image, 
a fairly accurate image rectification may be attained using the ImageAnalysis™ align 
tool, which uses a process known as “digital rubber-sheeting” to place an image into a 
map coordinate system.  If a more advanced rectification is desired, a photogrammetrist 
should be consulted.  The following steps may be used as a guideline for using the align 
tool in ArcView™’s ImageAnalysis™ package.  Please consult the ArcView™ 
ImageAnalysis™ Align tool help files for further information on image rectification.   
 

1. Add a theme, making sure to select image analysis data source as the data source 
type.   

 
2. If control point map coordinates are available, click the align tool button , 

which will change the cursor into a cross hair.  Then, simply click on the pixel 
that needs to be referenced to the control point, right-click to bring up the Align 
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menu and select Enter To Coordinate.  When the coordinate window opens, 
manually enter in the X and Y control coordinates and click the OK button.   

 
3. If the control point coordinates are not available for manual data entry, add 

another theme containing either a referenced drawing or a referenced image.   
 
4. Make the image analysis theme being rectified current, active, and on the top 

layer.   
 

5. Click the align tool button  again, this should change the cursor into a cross 
hair.  This will also move the un-rectified image into the same vicinity as the 
georeferenced image.   

 
6. Click on a pixel in the un-rectified image to be referenced to a control point on the 

rectified image.  Next, right-click on the view to bring up the Align menu and 
select Image to Bottom, which sends the current image to the bottom layer so that 
the georeferenced image is visible.  Finally, click on the pixel or drawing point 
that represents the control point in the georeferenced image.   

 
7.  The control points should cover as much distance in the image as possible with as 

many control points as possible.  A minimum of four control point pairs is 
necessary to generate a root mean squared (RMS) error analysis, which is 
displayed on the status bar at the bottom of the screen.  The idea is to make the 
RMS error as low as possible for best possible rectification.   

 
8. Once the image is rectified, simply go under the Theme menu and click on Save 

Image As…in order to save the newly rectified image as an ERDAS Imagine 
image (*.img), a GeoTIFF (*.tif), or an ArcView grid (*.rrd).   

 
Image Analysis 
 
After the aerial imagery has been rectified to a known coordinate system, the imagery 
may be analyzed for spectral reflectance and spatial change.  The categorization routine 
for spectral reflectance is described below.  A decision should be made as to how many 
categories are needed to yield the best possible results.  This usually is only possible after 
several iterative attempts at different categorization levels.  Usually between six and ten 
categories yields the best results.  Of course, a different number could apply to a specific 
study.   
 

1. Open a View document and load a rectified aerial image file as an Image Analysis 
Theme.   

 
2. Under the View menu select Properties and in the properties window set the Map 

Units to match the map units of the projection used to rectify the aerial 
photography to.  It is imperative that these units match properly.  A map unit 
mismatch will seriously alter any calculations made from the analysis.   
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  Image Histogram Stretch 
 

1. Make the image visible by checking the box next to the file name in the table of 
contents and make it active by selecting the image theme in the table of contents.   

 

2. Click the INLETGIS Histogram Stretch button  to display the histogram 
stretch control window (Figure 3).  Alternative ly, this window may be opened by 
selecting Image Histogram Stretch under the INLET menu.  This control window 
consists of seven buttons that represent different methods of image histogram 
stretches.  Histogram stretching is a method of changing the contrast of an image 
by adjusting the number of pixel spectral intensity values in each value bin (from 
0 to 255) of the image’s spectral reflectance intensity histogram.  The seven 
methods used here are described below.  See the ImageAnalysis™ Help files in 
ArcView™ for further explanation of each method:   

 
 
 

 
Figure 3.  Histogram stretch control window 
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a. Gaussian Stretch:  This method distributes the spectral values across the entire 
spectrum to form a normal curve in the data density bins and an S-shaped 
cumulative distribution curve.  This method is one of the better methods for 
quickly bringing out the location of sandy shoals in an image.   
 

b. Equalize Stretch:  This method is similar to the Gaussian method.  It examines at 
the original input histogram and redistributes those values across the bin 
spectrum, while retaining a similar histogram shape.   
 

c. Gamma Stretch:  This stretch creates a parabolic curve on the cumulative 
distribution curve.   

 
d. Level Slice:  This method applies a stair-step shape to the cumulative distribution 

curve.  INLETGIS selects twenty steps on the first click of this button, then 
decreases the number of steps by one each time the button is pressed thereafter. 
Once the Level Slice button is pressed twenty times, the very high contrast image 
can no longer be level sliced.   

 
e. Standard Deviations Stretch:  This method assumes that the image histogram 

starts as a normal curve and moves the pixel values to a distance away from the 
mean values.  INLETGIS moves the values one standard deviation away from the 
mean producing a fairly high contrast image.   

 
f. NONE:  Depressing this button returns the image to its original state before any 

histogram stretches were applied.   
 

g. Custom Stretch:  This button allows more advanced users to customize the 
histogram stretch to their own preferences.  Pressing the Custom Stretch button 
opens up the advanced histogram options window (Figure 4), where breakpoints 
on the cumulative curve may be moved to the desired position by using the 
pointer tool  and selecting breakpoints, added by clicking on the add 
breakpoint tool  and clicking on the yellow cumulative curve, or removed by 
clicking on the remove breakpoint  tool  and selecting the breakpoints desired 
for removal.   
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Figure 4.  The custom histogram stretch window for advanced histogram stretches 

 

  Image Classification 
 

1. Once a sufficient histogram stretch has been achieved, click the INLETGIS  

Image Classification button  to open the Select Classification Method window 
(Figure 5).  Alternatively, this window may be opened by selecting Classify 
INLET under the INLET menu.   

 
2. The Select Classification Method window (Figure 5) controls the type of 

classification desired. INLETGIS supports the Unsupervised Classification 
method.  However, the Supervised Classification method, which requires the user 
to select pixels of similar values to the area being classified, is supported by the 
BeachTools extension, which is covered in another CHETN (Hoeke et al. 2001).  
In order for the Supervised Classification button to work, BeachTools extension 
must be installed and loaded into ArcView™.  The classification described in this 
CHETN will only cover the Unsupervised method.  Make the image theme active, 
and click on the Unsupervised Classification button to continue with the 
INLETGIS image classification, which opens the Number of Classes window 
(Figure 6).   
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Figure 5.  Classification method control window 

 

 

 
Figure 6.  This window is where the user enters the desired number of classification categories 

 
 

3. The Number of Classes window (Figure 6) is where the user inputs the number of 
feature classification categories desired in the image.  Type a number in the box 
and click on the OK button to continue with the classification.   

 
4. At this point INLETGIS performs the image classification, smoothes the results, 

and converts the resulting theme to a shapefile.  Should the user prefer different 
classification colors or names, the legend editor will appear after this step (Figure 
7).  Consult ArcView™ Help on how to use the legend editor.   

 
5. Once the image has been classified, various spatial and temporal analyses may be 

performed to fit the user’s specific needs.  Spatial calculations, such as area, may 
be made in the classified shapefile’s theme table.  Change over timescale 
historical photosets may be made using the Thematic Change option under the 
Image Analysis menu.   
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Figure 7.  The Legend Editor appears after classification,  
which allows further customization of the shapefile 

 
 

  Shoreline Extraction 
 
The spectral response from pixels representing the shoreline will be included in any 
quantified aerial image analysis.  Therefore, if an analysis of just areas covered by water 
or shoals is desired, the shoreline and land classes must be extracted from the 
classification scheme.  The simplest and most precise method of shoreline extraction 
would be to import a surveyed shoreline polygon and use that polygon to clip out all 
landward classes.  A survey is not always available, and a set of methods to remove 
shoreline classes through spectral analysis is discussed below.   
 

1. Under the Image Analysis menu select seed tool properties and select a low value 
for the seed tool radius (5 or less pixels) and uncheck the box in front of “Include 
Island Polygons”.   

 
2. Make sure the image theme is active, and click on the seed tool button .  Use 

the seed tool to select pixels on the image that represent spectral values similar to 
other pixels in the shoreline or land regions.  This tool will make polygons around 
regions of similar spectral signature.  Continue creating polygons with the seed 
tool until the majority of the shoreline is represented.   
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3. Make a new theme by selecting New Theme under the View menu.   
 

4. Copy polygons from the image theme by selecting the polygons, then selecting 
Copy Graphics under the Edit menu.  Then, make the new theme active and select 
Paste under the Edit menu to paste the polygons into the new theme.   

 
5. Use the append polygon tool  to connect all the shoreline polygons.  If there 

are any edges that need to be extended or shortened, use the select vertices tool 
 to stretch the polygon.   

 
6. Use the pointer tool  to select all polygons.   

 
7. Under the Edit menu, select Union Features to create one large feature of 

landmass.   
 

8. Save the theme as a in the desired directory by selecting Save Edits As under the 
Theme menu, then select Stop Editing under the Theme menu.   

 
9. Make both the new shoreline theme and the INLETGIS classification theme 

active by selecting each theme in the table of contents while holding the shift key.  

To remove the shoreline data, click the INLETGIS Clip Theme button  and 
select Keep Features Outside Shoreline.   

 
 
Category Isolation and Extraction 
 
There are often cases where one specific category or portion of an image is to be 
examined in detail.  For instance, perhaps a study is to be conducted on how a shoal or a 
channel changes shape and size over the time domain of an historical aerial photoset.  In 
these cases it is best to isolate these categories or areas in the image from the other 
categories so that a more thorough analysis may be performed.  The following steps may 
be used to generate a theme that contains only the categories that the investigator cares to 
study more thoroughly.   
 

1. Use the select feature tool  to select the categories or portions of categories 
desired.  Hold the shift key down to select multiple regions.   

 
2. Under the Theme menu, select Convert to Shapefile….   

 
3. Add the shapefile to the view and make it active to view the isolated regions 

(Figure 8).   
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Figure 8.  Example of channel isolation 

 
 

  Import XYZ Data 
 
Another tool that is useful in the analysis of inlet environments are bathymetric survey 
data.  The XYZ Import tool allows the user to easily import XYZ data from a large file 
for viewing and manipulation.  XYZ files may be space or comma delimited.   
 

1. Prior to selecting the Import XYZ button , it must be determined that the view 
projection matches the mapping projection of the data points.  This may be 
accomplished by selecting Properties under the View menu and verifying by 
clicking the Projection button.  If the projections do not match, change 
appropriately.   

 
2. Click the INLETGIS Import XYZ button to select the input data file.  

Alternatively, this may be accessed under the INLET menu by selecting Import 
XYZ.   

 
3. Select the input file and click OK.   

 
4. The next window prompts the user to name an output file for the tabulated data 

(*.dbf).  Select a directory to save the tabulated data to and select OK.   
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5. Next, the Table Created…Continue? window (Figure 9) pops up, prompting the 

user to continue to import the *.dbf file as a point event theme into the active 
view.  This window also informs the user of the name of the newly created table 
(e.g., Table 1).  If Yes is selected, the import process continues and the Table 
Name window opens.  If No is selected, the import process terminates and the user 
is brought to the imported table, but no new point theme will exist in the view.   

 
6. The Table Name window then prompts the user to select the table he/she wishes 

to import to the active view.  Select the desired table to import as points to the 
active view from the pull down list and select OK.  This action will import a point 
theme representing the data points in the XYZ file into the active view (Figure 
10).   

 
 

 
Figure 9.  New table created using import XYZ data tool 
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Figure 10.  Example of XYZ survey data points imported into the view 

 
Manipulation of XYZ Point Data 
 
Many options exist for further examination of the imported XYZ data.  These options 
were not automated due to the varied needs of custom tailoring data handling options to 
match site specific and project specific goals.  This section of the technical note will 
briefly describe some common data handling practices for creating digital elevation 
models (DEM) in ArcView™.  For more information on handling point data in 
ArcView™, please consult the ArcView™ manual or help files.  Most of these functions 
are accessed under the Surface menu, which requires the ESRI™ 3D Analyst™ 
extension.  The analysis extent properties and masking options are accessed under the 
Analysis menu, which requires the ESRI™ Spatial Analyst™ extension.   
 
Interpolating a Grid 
 
This process of data visualization involves the creation of a block of square grid cells at 
user-assigned cell resolution values, which represent interpolated data values generated 
from the point data.   
 

1. Under the Surface menu, select Interpolate Grid…. 
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2. The Output Grid Specification window allows the user to select the output grid 
extent.  In most cases this should be set the same as the data point theme extent.  
The cell resolution and block size may also be manually adjusted in this window.  
It is best to leave the number of columns and rows at the values given by the 
output grid extent.  However, the output grid cell size may be adjusted to a 
resolution that matches the needs of the user.  It is important to consider that as 
grid resolution is increased the computer must execute more calculations, 
resulting in longer processing times.  After the grid specifications have been 
selected, click the OK button.   

 
3. ArcView™ interpolates data using one of two interpolation methods:  Spline and 

Inverse Distance Weighted (IDW).  The Spline method of interpolation is best 
used when there are no drastic changes in elevation and when data points are 
somewhat evenly spaced.  If drastic elevation jumps occur or if data are not 
evenly spaced, it is best to use the IDW method of interpolation so that excessive 
spline curvature errors are not introduced.  The user will normally select the Z 
(elevation) column of data for the Z value field. In instances where IDW is used, 
the user may decide to use the Fixed Radius option, which limits the interpolation 
of the point data to within a user-defined radius of each interpolation point.  This 
may be useful in situations where there is data on both sides of a barrier island 
and the user does not wish to interpolate across the barrier island.  Other methods 
of preventing interpolation across islands are by introducing a masking theme or a 
break-line theme.  Mask themes may be used under the Analysis menu under 
Properties…, and break-line themes may be used under the Barriers section of the 
IDW grid interpolation window.  Further information on mask grids and break-
lines may also be found in the ArcView™ help files.  Finally, once all of the 
interpolation properties have been set, the user should select OK and the grid is 
then calculated and opened in the view as a new grid theme.   

 
Creating a Triangulated Irregular Network (TIN) 
 
This process of data visualization involves the creation of a surface that consists of 
irregular triangles linking the data points.  Data is interpolated between the triangles.  
Mask themes may be used under the Analysis menu for TIN surfaces, as well as grid 
surfaces.  
 

1. Next to Surface, select Create TIN from Features….   
 

2. Next to Height Source, select Z (elevation) data.   
 

3. Next to Input as, select Mass points.   
 

4. Next to Value Field, select <none>, select OK.   
 

5. The Output TIN Name window will appear, specify name and directory to save 
the output file, select OK.   
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Creating Contours 
 
This process of data visualization involves the creation of lines of constant elevation, 
which may be created from the data points using methods similar to the methods used for 
creating a grid.  Contour lines may also be rapidly computed from a grid using the 
following steps:   
 

1. Select the grid theme as the current and active theme.   
 

2. Under the Surface menu, select Create Contours….   
 

3. Select the contour interval and base contour (i.e. starting contour).   
 

4. Select OK.   
 

5. The display properties of the contours may be altered by double-clicking on the 
contour theme, then selecting Graduated Color under Legend Type, and next to 
Classification Field selecting contour.  Other options for changing the contour 
display properties exist under the Classify and Color Ramps selections in the same 
window.   

 
6. To edit the contours, make the contour theme active, then select Start Editing 

under the Theme menu.  Use the select feature tool  to select individual or 
multiple contour lines, and then press the delete key on the keyboard to remove 
selected lines.  If a line is mistakenly deleted, click and hold the right mouse key 
and select Undo Feature Edit.  The select vertices tool  can be used to 
manipulate individual vertices along the line.  To save edits, select Save Edits or 
Stop Editing under the Theme menu.  Select Yes to save edits, or No to reject 
edits.  Edits can also be saved in a new file by selecting Save Edits As.  Ensure 
that contour lines are not selected when ending an editing session (if selected, 
they will appear highlighted, or a different color than the rest of the theme).   

 
FURTHER APPLICATIONS AND LIMITATIONS:  Although this imagery analysis 
tool provides a rapid form of analyzing inlet dynamics, there are several limitations to the 
usefulness of this tool.  Since this tool is based on aerial imagery, the analysis is limited 
to a snapshot in time and can only be correlated to the conditions present at the time 
represented by the image.  As a result, not only the date, but also the time of the 
photograph must be known in order to account for changes sea level due to tides and 
wind.  Sea level changes will, of course, affect the spectral reflectance signal due to the 
amount of water covering a shoal or channel.  In order for a long-term geomorphologic 
quantification analysis to be conducted using this tool, sea level data must be known for 
the time of the images, and short-term changes for shoreline position between the 
photograph sets should be accounted for in order to significantly decrease errors (Smith 
and Zarillo 1990).  Spectral signals are often distorted or contaminated due to the 
following factors:  Sun glint, turbidity changes and plumes, photo exposure, and bottom 
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composition.  Breaking and refracting waves may also be another source of spectral 
signal contamination, although these are also good indicators of the edges of shoals 
(Stauble 1998).  As a result, this analysis method is site specific to tidal inlets with a 
relatively clear and uniform water column and a relatively uniform bottom composition.  
Adjustments may be made to adapt the methodology to a particular site, but it is difficult 
to compare one site to another using this method, unless the sites are very similar with 
respect to water and bottom composition.  Errors may also be brought into the analysis if 
the images are poorly georeferenced.   
 
Despite a number of errors present in this analysis method, there are many advantages to 
this tool.  A quick large-scale assessment of the processes in a tidal inlet may be made 
from these methods.  These methods could potentially be used as a vital tool in the 
assessment of the condition of a tidal inlet shortly after a storm, as it is often easier to 
mobilize an aerial photo survey than it is to perform and produce a bathymetric and 
topographic survey in such conditions.  Another advantage of this tool presents itself in 
the analysis of historical photosets.  Shoal and channel evolution becomes very obvious 
when comparing photosets from the same location at different periods in time.  Images 
may also be used from years where no bathymetric survey was conducted.  These remote 
sensing techniques could also be used in conjunction with sediment budgets to give better 
insight into sand migration patterns during an existing conditions or historical conditions 
and may give insight into future conditions (Rosati and Kraus 1999).   
 
ADDITIONAL INFORMATION:  This note was produced under the Coastal Inlets 
Research Program (CIRP) work unit “Inlet Channels and Adjacent Shorelines” by 
Mr. Kenneth J. Connell and Dr. Gary A. Zarillo, Department of Marine and 
Environmental Systems, Florida Institute of Technology.  Questions about this Technical 
Note can be addressed to Mr. Connell at kconnell@fit.edu or to Dr. Zarillo at 
zarillo@fit.edu.  For further information about the CIRP, please consult the web site 
http://cirp.wes.army.mil/cirp/cirp.html or contact the CIRP Program Manager, 
Dr. Nicholas C. Kraus at Nicholas.C.Kraus@erdc.usace.army.mil or by telephone at 
(601) 634-2016.  This CHETN should be cited as follows:   
 

Connell, K.J., and Zarillo, G.A.  (2002).  “Application of Remote Sensing 
Techniques for Shoal and Channel Change Analysis at Tidal Inlets,” 
Coastal and Hydraulics Engineering Technical Note ERDC/CHL CHETN-
IV-___, U.S. Army Engineer Research and Development Center, 
Vicksburg, MS, (http://chl.wes.army.mil/library/publications/chetn).   
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